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Important User Notices 

Copyright  1991-2014 Delcam Ltd. All rights reserved. 

Delcam Ltd has no control over the use made of the software 

described in this manual and cannot accept responsibility for any 
loss or damage howsoever caused as a result of using the software. 

Users are advised that all the results from the software should be 

checked by a competent person, in accordance with good quality 

control procedures. 

The functionality and user interface in this manual is subject to 

change without notice in future revisions of the software.  

The software described in this manual is furnished under licence 

agreement and may be used or copied solely in accordance with the 

terms of such licence. 

Delcam Ltd grants permission for licensed users to print copies of 

this manual or portions of this manual for personal use only. 

Schools, colleges and universities that are licensed to use the 

software may make copies of this manual or portions of this manual 
for students currently registered for classes where the software is 

used. 
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PartMaker is the world's leading CAM system for automating the 
programming of production machining on CNC milling machines, 

lathes, Wire EDMs, Turn-Mill centers and Swiss-type lathes. 

PartMaker automates the tedious task of manual part programming 

by providing an easy-to-use graphical interface and powerful tools 
and features. 

With PartMaker you can quickly define part geometry, cycle, tool, 

and material information, and all other parameters associated with 

machining a part. What's more, you can also save frequently used 
tool, cycle, and material information in a database to recall and 

reuse at any time. 

Acquired by Delcam Ltd in 2006, PartMaker Inc. is a wholly owned 

subsidiary of Delcam Ltd, the world’s leading developer and supplier 

of complete CAD/CAM software solutions. 

About this guide 

Use this guide to find out about: 

 Installing PartMaker (see page 2). 

 What's new in PartMaker 2015 (see page 7). 

 Accessing help and support (see page 81). 

 

Introduction 
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To install PartMaker on a stand-alone PC: 

1 Before installing PartMaker, make sure you meet the system 

requirements (see page 3). 

2 Install PartMaker. 

3 Install your license file (PAF). 

 If you use post processors for PartMaker/SwissCAM or 

PartMaker/Turn-Mill, you need to install the post processors 
you require (using the Help > Download Licensed Post Config 

Files menu option) before starting to use PartMaker. 

If you need further details about the installation process, or you are 
installing PartMaker for use on a network, refer to the Installation 

Guide on your PartMaker Documentation CD for more information. 

 

Installing PartMaker 
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System requirements 
The system requirements for PartMaker 2015 and higher are: 

 Standard 
PartMaker 

Parasolid 
Import 
Module 
(Solids) 

Full 
Machine 
Simulation 
(FMS) 

Advanced 
Surface 
Machining 
(ASM) 

Processor Pentium 3 
800 MHz or 

higher 

Pentium 3 
800 MHz 

or higher 

Pentium 4 
3 GHz or 

higher 

Intel Core 
Duo 

processor 

or higher 

Memory 512 MB or 

more 

1 GB or 

more 

2 GB or 

more 

4 GB or 

more 

Hard drive 40 GB 40 GB 40 GB 80 GB 

Independent 
video card 

128 MB 
NVIDIA 

512 MB 
NVIDIA 

512 MB 
NVIDIA 

1 GB 
NVIDIA 

Operating systems 

64-bit versions of PartMaker are available and are supported on 

Windows 7 and higher. 

 32-bit versions of PartMaker are available and are supported 

on Windows 7 only. 

 PartMaker 2015 does not support Windows XP or Windows 

Vista. Although you may be able to run PartMaker 2015 on 

these operating systems, Delcam will not address any 
software performance issues found on Windows XP or 

Windows Vista that cannot be reproduced on Windows 7 or 

higher. 
 

Installing PartMaker on a stand-alone 
PC 

To install PartMaker:  

1 When you have started the computer and Microsoft Windows is 
running, insert the PartMaker Installation CD into the CD drive. 
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2 The Installer prompts you to select the language used on the 

dialogs displayed during the installation. The default selection is 

English. If PartMaker is available in the language you select, the 
translated version is installed. Select the language and click OK. 

 

3 The PartMaker Setup program starts and the PartMaker Setup 

screen is displayed: 

 

 If the Setup program does not start automatically, use My 

Computer (or Computer for users of Windows Vista and 

higher) to browse the contents of the CD and double-click 
setup.exe to start the Setup program. 

 Using Windows 7 or higher, you may see an AutoPlay dialog 

when the Installation CD is inserted. Click Install or Run 

Program to start the installation. If the Account Control 

Manager screen is displayed, click Allow to continue with the 

installation. 

4 Follow the on-screen installation instructions to complete the 

installation. 

5 When the installation is complete, install your license file. 
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Installing the license file (PAF) 
PartMaker is protected using a combination of: 

 a dongle, which plugs into a USB or parallel port on the 

computer; and 

 a Product Authorization File (PAF) license file, which you install 
onto the computer. 

PAFs are usually sent in an email from Delcam Ltd or from the 

PartMaker, Inc. division of Delcam. The email is sent to the email 

address that was registered when your company purchased 
PartMaker. You may receive the PartMaker installation software 

before you receive the PAF file. Because you can only use PartMaker 

if a valid PAF is installed, Delcam recommends that you do not 

install PartMaker until you have received your PAF. 

To install the license file (PAF): 

1 Close PartMaker and any other Delcam programs running on the 

computer. 

2 Open the email containing your PAF. The email has several 

attachments.  

 If the attachments are in a zip file (so they are accepted by 

your email's virus scanning software), unzip the file before 

continuing. 

3 Follow the instructions in the email to install the PAF, making 
sure you place your PAF in the correct folder: 

 On a 32-bit computer, place your PAF in C:\Program 

Files\Common Files\Delcam 

 If you have installed a 32-bit version of PartMaker on a 64-bit 

computer, place your PAF in  
C:\Program Files (x86)\Common Files\Delcam 

 If you have installed a 64-bit version of PartMaker on a 64-bit 
computer, place your PAF in  
C:\Program Files\Common Files\Delcam 

4 When you have installed the PAF and plugged in the dongle, you 

can start PartMaker by double-clicking the PartMaker desktop 

shortcut. For example, to start the 64-bit version of 

PartMaker/SwissCAM, double-click: 
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 If you use post processors for PartMaker/SwissCAM or 

PartMaker/Turn-Mill, you need to install the post processors 
you require (using the Help > Download Licensed Post Config 

Files menu option) before starting to use PartMaker. 
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PartMaker 2015 contains many new features and enhancements. 
 

File compatibility in PartMaker 
ConfigPost file compatibility 

 .pst and .sub files produced in ConfigPost 2014 are compatible 

with PartMaker 2015.  

 .pst and .sub files produced in ConfigPost 2015 are not compatible 

with PartMaker 2014. If you try to open such files in PartMaker 
2014, a message dialog is displayed saying that there is a 

problem opening the Post Configuration file. 

 .pst and .sub files produced in ConfigPost 2015 are recognized by 

a '-ve' suffix placed after the name, for example, 
Citizen_M3_32-ve122.pst. 

PowerMill Project file compatibility 

PartMaker/Turn-Mill and PartMaker/SwissCAM 2015 can import 

PowerMILL Projects created in PowerMILL V2015 R1 SP6 and lower. 

Inventor *.IPT file compatibility 

All PartMaker 2015 modules can import files created in Autodesk 

Inventor V2015 and lower. 

SolidWorks *.SLDPRT file compatibility 

All PartMaker 2015 modules can import files created in SolidWorks 

V2015 and lower. 

What's New in PartMaker 
2015 
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Parasolid *.X_T, *.X_B file compatibility 

All PartMaker 2015 modules can import Parasolid files V26 and 

lower. 

Pro/Engineer *.prt file compatibility 

All PartMaker 2015 modules can import files created in Wildfire 5 
and lower. 

Creo *.prt file compatibility 

All PartMaker 2015 modules can import files created in Creo 2.0 and 
lower. 

 
 

Post Processor Reference Guides 
In PartMaker/SwissCAM and PartMaker/Turn-Mill 2015 you can now 

create Post Processor Reference Guides that describe the CNC 
programming capabilities of licensed post processors (Post 

Configuration files).  

Previously, Delcam provided machine-specific addendum documents 

to describe licensed post processors. These addendums were 
downloaded to your machine when you used the Help > Download 

Licensed Post Config Files option to download licensed Post 

Configuration files. 

Addendums typically contained both the CNC programming 

capabilities of the Post Configuration file and specific information 

related to using the Post Configuration file in conjunction with the 
PartMaker interface. Some Post Processor Reference Guides contain 

a link to a document called a Reference Guide Supplement. 

Reference Guide Supplements contain only information related to 

using a specific Post Configuration file in conjunction with the 
PartMaker interface. 

Over time, Post Processor Reference Guides and Reference Guide 

Supplements will replace machine-specific addendum documents. 

However, during this transition PartMaker will continue to provide 
addendum documents for licensed Post Configuration files. 

Delcam recommends that you use Post Processor Reference Guides 

whenever possible for information relating to the CNC programming 

capabilities of licensed post processors, as they offer several 

advantages over machine-specific addendum documents: 

 All Post Processor Reference Guides use a standard layout and 

contain the same level of information. 
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 A Post Processor Reference Guide is specific to the currently 

loaded post processor and machine (not to a range of machines). 

 You can create a Post Processor Reference Guide at any time, by 
selecting the Job Optimizer > Create Post Processor Reference 

Guide option, so you can be sure it contains the most up-to-date 

information available about the post processor. 

 If you modify a Post Configuration file supplied by Delcam, 

you must ensure that the modifications do not prevent 
PartMaker from creating an accurate Post Processor Reference 

Guide for that post processor. Refer to a Post Processor 

Reference Guide for more details on how your modifications 

may affect the creation of Post Processor Reference Guides. 
 

Creating Post Processor Reference Guides 

To create a Post Processor Reference Guide for the currently loaded 

Post Configuration file in PartMaker/SwissCAM or 

PartMaker/Turn-Mill: 

1 Select Job Optimizer > Create Post Processor Reference Guide to 

display the Create Post Processor Reference Guide dialog: 

 

2 Specify how PartMaker will open the Post Processor Reference 
Guide. 

 Default Web Browser — Displays the Post Processor Reference 

Guide in your default web browser. 

 Microsoft Office Word — Displays the Post Processor Reference 

Guide in Microsoft Word. 

 PartMaker creates all Post Processor Reference Guides as 

.html files, but you can choose to view them in a web 

browser or in Microsoft Word. 

3 Click Create. PartMaker displays the Save Post Processor 

Reference Guide dialog. 

4 Select a folder and filename for the Guide, and then click Save.  
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PartMaker creates and displays the Post Processor Reference 

Guide. For example: 
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Using feeds and speeds 
There are several changes to how you can use feeds and speeds in 

PartMaker.  

 Set feeds and speeds per tool (see page 11). 

 Lock feeds and speeds per process (see page 13). 

 Specify the spindle direction (see page 15). 

 Feed and speed factors moved to a new dialog (see page 17). 
 

Tool-based feeds and speeds 

In PartMaker/SwissCAM, PartMaker/Turn-Mill, PartMaker/Mill, and 

PartMaker/Turn, you can specify machine feed rates and spindle 
speeds for each tool using the new Cutting Data dialog.  

To display the Cutting Data dialog, click the Cutting Data button on 

either the Tool Data or Edit Tool dialogs. 
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The settings available on the Cutting Data dialog depend on the type 

of tool you are using, and not all settings are available for every 

tool. 

 

Type of Cut — Select whether the tool is used for a roughing or 

finishing operation. If the tool can be used only for one type of 

operation, this field is unavailable. 

Rough Cut — Select if the tool is used for a roughing operation. 

Finish Cut — Select if the tool is used for a finishing operation. 

Feeds and Speeds Values — Select whether to use the values 

calculated by PartMaker, or to define your own feeds and speeds 

values.  

Calculated — When selected, PartMaker calculates values based 

on the Material file. 

User Defined — When selected, you can enter your own values in 

the available fields. 
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Units (Feeds) — Select the units used to specify the feed rates. 

upr — Select if you want to specify the value in 

units-per-revolution. 

upm — Select if you want to specify the value in 

units-per-minute.  

 For Turning tools, only upr is available because upm 

depends on the stock diameter, which is not defined per 

tool. 

Cutting Feed — Enter a value for the tool's cutting feed rate. 

Plunge Feed — Enter a value for the tool's plunge feed rate. 

Units (Speeds) — Select the units used to specify the spindle speed. 

fpm / mpm — Select if you want to specify the value in 

feet-per-minute (fpm) if you are working in the inches system or 

meters-per-minute (mpm) if you are working in the metric 

system. 

rpm — Select if you want to specify the value in 

revolutions-per-minute. 

 For Turning tools, only fpm is available because rpm 

depends on the stock diameter, which is not defined per 

tool. 

Spindle Speed — Enter a value for the spindle speed.  

Tool Speed — Enter a value for the tool speed. This field is available 

only for Thread Whirl tools. 

Notes — Enter any additional information about the cutting data.  

Apply — Click to recalculate the units. If you are using a Turning 

tool, this field is unavailable because you cannot change the units. 

OK — Click to apply your changes and close the dialog. 

Cancel — Click to discard any changes that have not been applied 

and close the dialog. 
 

Locking feeds and speeds 

In PartMaker 2015, the feeds and speeds settings on the Process 

Parameters dialogs are grouped together in a Feeds and Speeds 

area. Within this area, a Lock Feeds and Speeds option enables you 

to lock all these settings, which means the feeds and speeds can 
still be retained when: 

 generating a Process Table with Retain Process Table 

Modifications deselected. 
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 generating a Process Table with Retain Process Table 

Modifications selected, and a different material file loaded. 

The Lock Feeds and Speeds option is deselected by default when a 

Process Table is generated for the first time. When selected, all 
values within the Feeds and Speeds area are locked.  

Process Parameters (Turn): 
unlocked 

Process Parameters (Turn): 
locked 

  

There is an Unlock Feeds and Speeds in All Processes option on the 

Job Optimizer menu. This option is disabled if there are no processes 

with locked feeds and speeds. 
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On the Process Table, a padlock icon is displayed beside feeds and 

speeds that are locked. 

 
 

Setting the spindle direction 

In PartMaker/SwissCAM, PartMaker/Turn-Mill, PartMaker/Turn, and 
PartMaker/Mill, a drop-down list is added to the Tool Data, Edit Tool, 

and Process Parameters dialogs, which enables you to set the 

direction of the spindle, either per tool, or per process. This means 
you no longer have to enter a Speed Factor of -1 in the Tool Data 

and Edit Tool dialogs, or enter a negative speed in the Process 

Parameters dialog to reverse the direction of the spindle. 

The following settings are available from the Spindle Direction 

drop-down list: 

cw — Select to set a clockwise rotation for the spindle. 

c-cw — Select to set a counter-clockwise rotation for the spindle. 

When you select a counter-clockwise spindle direction, a minus 
symbol is displayed in front of the Speed value in the Process 

Table. 
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none — Select this option to stop the spindle rotating. The 

Spindle Speed is set to 0, and the field is disabled. 

Setting the spindle direction for a tool 

In the Tool Data and Edit Tool dialogs, select an option from the 

Spindle Direction drop-down list to set the the direction of the 

spindle per tool. 

 

 When you open the Edit Tool dialog from the Process Table 

and change the spindle direction, PartMaker will not 
immediately change the spindle direction in all processes 

where this tool is used. You must regenerate the Process 

Table to update the Spindle Direction. 

Setting the spindle direction for a process 

When a Process Table is generated, the spindle direction setting is 

copied from a tool to a process. In the case of a Turning process, 

the spindle direction could be different between main spindle and 

sub-spindle processes using the same tool. 

In the Process Parameters dialogs, select an option from the 

drop-down list to set the direction of the spindle for a process.  

 For turning processes, select an option from the Turning Spindle 

Direction drop-down list to set the spindle direction: 

 



 

 PartMaker 2015 What's New in PartMaker 2015 • 17  

 For milling and surfacing processes, select an option from the 
Tool Spindle Direction drop-down list to set the spindle direction: 

Process Parameters (milling) Process Parameters 
(ASM) 

 
 

 
 

Feed and speed factors moved to a new dialog 

The Feed Factor and Speed Factor settings are now located on the 

Feed and Speed Factors dialog. Previously, these settings were 

available from the Tool Data and Edit Tool dialogs.  

 

To display the Feed and Speed Factors dialog, click Feed and Speed 

Factors on the Tool Properties dialog. 

 

Feed and speed factors are kept for compatibility with old job files. 

They should no longer be used in PartMaker 2015 because you can 
now enter cutting data per tool with the new Cutting Data dialog 

(see page 11), and set the spindle direction with the Spindle 

Direction option on the Tool Data and Edit Tool dialogs (see page 

15). 
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Improvements to hole canned cycles 
Canned cycles simplify the NC Program for the part by using a 

single G-code to initiate a sequence of machine operations.  

In PartMaker 2015 the handling of canned cycles is improved, and 

several areas are updated as a result of these improvements: 

Edit Hole Operation dialog (see page 19) — There is a new Edit Hole 

Operation dialog, where you can view, and in some cases modify, 

settings for machining holes. 

New hole canned cycles — There are three new canned cycles for 

machining holes: 

Turning and milling: 

 CHIP BREAK canned cycle (see page 23)  

 VARIABLE STEP canned cycle (see page 25)  

Milling only 

 HELICAL MILL canned cycle (see page 27) 

Postprocessing canned cycles (see page 73) — There are several 

changes to ConfigPost to support the improvements to hole canned 
cycles. 

Changes to other dialogs (see page 29) — There are a number of 

changes to other dialogs as a result of the improvements to canned 

cycles. 
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Edit Hole Operation dialog 

In PartMaker 2015, there is a new Edit Hole Operation dialog that 

enables you to view and specify settings for machining a hole 

canned cycle. 

 

To display the Edit Hole Operation dialog, click the new Edit Hole 

Operation  button beside the operation you want to edit on either 

the Cycles Data or Edit Cycle dialogs . This button is displayed only 

beside operations that have a tool selected. 
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When the Edit Hole Operation dialog is displayed, the button that you 

clicked to open it turns orange  to make it clear which operation 
you are editing. 

The settings available on the dialog depend on which hole canned 
cycle you have selected on the Cycles Data or Edit Cycle dialog. 

Hole Canned Cycle — This field displays the name of the hole canned 

cycle selected on the Cycles Data or Edit Cycle dialogs. 

Style — Select the style for machining the hole. 

For RIGID TAP hole canned cycles, the following options are 

available: 

 Single Step — Select to tap the hole using a single step. 

 Multiple Steps — Select to tap the hole using multiple steps. 

For THREAD MILL hole canned cycles, the following options are 
available: 

 Bottom Up — Select so the tool starts at the bottom of the 

hole and threads up to the top of the hole. 

 Top Down — Select so the tool starts at the top of the hole 

and threads to the bottom of the hole. 

Thread Direction — Select the direction of the thread: 

 Right Hand — Select to cut a right-handed thread, which is 

standard in threading applications. 

 Left Hand — Select to cut a left-handed thread. 

 This field is displayed only for THREAD MILL hole canned 

cycles. 

Helical Step Defined By — Select how the step is defined: 

 Pitch — Select to define the step by the pitch of the helix. The 

Pitch (p) field is displayed in the Depth area. 

 Angle — Select to define the step by the angle of the helix. 

The Angle (A) field is displayed in the Depth area. 

 This field is displayed only for HELICAL MILL hole canned 

cycles. 

Hole Diameter (D) — This field displays the diameter of the hole. The 

value is taken from the Hole Diam field on the Cycles Data or Edit 

Cycle dialogs. 

Tool Diameter (d) — This field displays the diameter of the tool. The 

value is taken from the Tool Data or Edit Tool dialogs. 
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 This field is displayed only for CIRCLE MILL, THREAD MILL, 

and HELICAL MILL hole canned cycles. 

Radial Step (p) — Enter the amount of material removed in each 

circular pass. If the Tool Parameter  button is displayed, the value 

is taken from either the Tool Data or Edit Tool dialogs. If the User 

Defined Parameter button is displayed, you can modify the value. 

Click  to change it to . 

 This field is displayed only for CIRCLE MILL hole canned 

cycles. 

Depth (H) — This field displays the depth of the hole. The value is 

taken from the Depth field on the Cycles Data or Edit Cycle dialogs. 

Axial Step (Q) — Enter the depth of the steps used to drill the hole. 

If the Tool Parameter  button is displayed, the value is taken from 

the Tool Data or Edit Tool dialogs. If the User Defined Parameter  

button is displayed, you can modify the value. Click  to change it 

to . 

 This field is displayed only for CHIP BREAK, DEEP HOLE, 
VARIABLE STEP, RIGID TAP (with Multiple Steps selected), 

and CIRCLE MILL canned cycles. 

Step Decrease (s) — After the initial step, the step decreases until a 

minimum step is reached.  

 This field is displayed only for VARIABLE STEP hole canned 
cycles. 

Minimum Step (m) — The step does not decrease below this value. 

 This field is displayed only for VARIABLE STEP hole canned 

cycles. 

Feed Factor for Initial Step — Enter a value to modify the feed rate 

entered in the Process Table by a factor on the initial step. 

 This field is displayed only for VARIABLE STEP hole canned 

cycles. 

Pitch (P)  

 For THREAD MILL hole canned cycles — Enter the distance 

between the teeth of the thread when drilling the hole. The 

default value of this option is calculated from the Threads Per 

Inch value (Inch units) or taken from the Pitch value (metric 
units) from the tool's properties in the Tool Data dialog. 
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 For HELICAL MILL hole canned cycles — Enter the pitch of the 
helix. This field is displayed only if Pitch is selected in the Helical 

Step Defined By drop-down list.  

 For both THREAD MILL and HELICAL MILL hole canned cycles — 

If the Tool Parameter  button is displayed, the value is taken 

from the Tool Data or Edit Tool dialogs. If the User Defined 

Parameter  button is displayed, you can modify the value. 

Click  to change it to . 

Angle (A) — Enter the angle of the helix. This field is displayed only 

if Angle is selected in the Helical Step Defined By drop-down list.  

 This field is displayed only for HELICAL MILL hole canned 
cycles. 

Number of Spring Passes — Enter the number of clean-up passes 

taken at the bottom of a hole. 

 This field is displayed only for HELICAL MILL hole canned 

cycles. 

Retract Type 

 Full Retract — After each step, the tool retracts completely out 

of the hole. 

 Partial Retract — After each step, the tool retracts up the hole 

to the distance defined in the Retract Distance (r) field. 

 Retract Type is programmable only for VARIABLE STEP hole 

canned cycles. 

Retract Motion 

 Rapid — For all cycles except BORE and BORE,DWELL, the tool 

makes a rapid move out of the hole when it retracts. 

 Linear — For BORE and BORE,DWELL hole canned cycles, the 

tool makes a linear move out of the hole at the feed rate 

entered on the Process Table when it retracts. 

Retract Distance (r) — If Partial Retract is specified in the Retract Type 

drop-down list, enter the distance that the tool retracts up the hole 

between steps. 

 This field is available only for CHIP BREAK and VARIABLE 

STEP (with Partial Retract selected) hole canned cycles. 

Output Hole Canned Cycle — This option is selected by default so the 

machining operation for the hole is output as a canned cycle in the 

NC Program file. If your postprocessor does not support all of the 

parameters for this canned cycle, deselect this option. 
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Thread Mill Options — Click to display the Thread Mill Options dialog, 

where you can control the start angle of the thread and whether a 

tapered thread is required. 

OK — Click to save any changes and close the dialog. 

Cancel — Click to discard any changes and close the dialog. 

 
 

Using the CHIP BREAK canned cycle 

When creating, or editing, a cycle, you can now select a CHIP 

BREAK canned cycle for machining holes.  

The CHIP BREAK canned cycle drills a hole in several stages 

(multiple step), where the tool partially retracts after each step. 

To create a cycle that uses the CHIP BREAK hole canned cycle: 

1 Select ToolMinder > Cycles to display the Cycles Data dialog. 

2 Complete the settings on the dialog and select CHIP BREAK as 
the Hole Canned Cycle: 

 

3 Click the Edit Hole Operation  button to display the Edit Hole 

Operation dialog for the CHIP BREAK canned cycle. 
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 This button is displayed only if you have selected a tool. 

 

4 On the Edit Hole Operation dialog, specify the following settings to 

control how holes are machined when using the CHIP BREAK 

cycle: 

 Axial Step (Q) — Enter the depth of the steps used to drill the 

hole. If the Tool Parameter  button is displayed, the value is 
taken from the Tool Data or Edit Tool dialog. If the User 

Defined Parameter button is displayed, you can modify the 

value. Click  to change it to . 

 Retract Distance (r) — Enter a value to control how far the tool 

retracts up the hole between each step. 

 Output Hole Canned Cycle — This option is selected by default 

so the machining operation for the hole is output as a canned 

cycle in the NC Program file. If your postprocessor does not 

support any of the parameters for this canned cycle, deselect 
this option. 

5 Click OK to close the Edit Hole Operation dialog and return to the 

Cycles Data dialog.  
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6 When you have completed creating, or editing, the cycle, click 
Close on the Cycles Data dialog.  

 

Using the VARIABLE STEP canned cycle 

When creating, or editing, a cycle, you can now select a VARIABLE 
STEP canned cycle for machining holes. 

The VARIABLE STEP canned cycle drills a hole where the step 

amount decreases after each step until a minimum step is reached. 

The minimum step is maintained until the bottom of the hole is 
reached.  

To create a cycle that uses the VARIABLE STEP hole canned cycle: 

1 Select ToolMinder > Cycles to display the Cycles Data dialog. 

2 Complete the settings on the dialog and select VARIABLE STEP 
as the Hole Canned Cycle. 

 

3 Click the Edit Hole Operation  button to display the Edit Hole 

Operation dialog for the VARIABLE STEP canned cycle. 
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 This button is displayed only if you have selected a tool. 

 

4 On the Edit Hole Operation dialog, specify the following settings to 

control how holes are machined when using the VARIABLE STEP 

canned cycle: 

 Axial Step (Q) — Enter the depth of the steps used to drill the 

hole. If the Tool Parameter  button is displayed, the value is 
taken from the Tool Data or Edit Tool dialogs. If the User 

Defined Parameter  button is displayed, you can modify the 

value. Click  to change it to . 

 Step Decrease (s) — After the initial step, the step decreases 

until a minimum step is reached.  

 Minimum Step (m) — The step does not decrease below this 

value. 

 Feed factor for Initial Step — Enter a value to modify the feed 

rate entered in the Process table by a factor on the initial 

step.  
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 Retract Type — Select a retract type: 

Full Retract — After each step, the tool retracts completely out 

of the hole. 

Partial Retract — After each step, the tool retracts up the hole 

to the distance defined in the Retract Distance (r) field. 

 Output Hole Canned Cycle — This option is selected by default 

so the machining operation for the hole is output as a canned 

cycle in the NC Program file. If your postprocessor does not 

support all of the parameters for this canned cycle, deselect 
this option. 

5 Click OK to close the Edit Hole Operation dialog and return to the 

Cycles Data dialog. 

6 When you have completed creating, or editing, the cycle, click 
Close on the Cycles Data dialog. 

 

Using the HELICAL MILL canned cycle 

When creating, or editing, a cycle, you can now select a HELICAL 
MILL canned cycle for machining holes. 

The HELICAL MILL canned cycle machines a hole with an endmill 

tool that is smaller than the hole. 

To create a cycle that uses the HELICAL MILL hole canned cycle: 

1 Select ToolMinder > Cycles to display the Cycles Data dialog. 

2 Complete the settings on the dialog and select HELICAL MILL as 
the Hole Canned Cycle. 

 

3 Click the Edit Hole Operation  button to display the Edit Hole 

Operation dialog for the HELICAL MILL canned cycle. 
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 This button is displayed only if you have selected a tool. 

 

4 On the Edit Hole Operation dialog, specify the following settings to 

control how holes are machined when using the HELICAL MILL 

canned cycle: 

 Helical Step Defined By — Select how the step is defined. 

 Pitch (P) — Enter the pitch of each helical step. This field is 

displayed only if Pitch is selected in the Helical Step Defined By 

drop-down list. 

 Angle (A) — Enter the angle of each helical step. This field is 

displayed only if Angle is selected in the Helical Step Defined 

By drop-down list. 

 Number of Spring Passes — Enter the number of clean-up 

passes taken at the bottom of a hole. This is not used for 

through-holes. 

 Output Hole Canned Cycle — This option is selected by default 

so the machining operation for the hole is output as a canned 

cycle in the NC Program file. If your postprocessor does not 

support any of the parameters for this canned cycle, deselect 
this option. 
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5 Click OK to close the Edit Hole Operation dialog and return to the 

Cycles Data dialog. 

6 When you have completed creating, or editing, the cycle, click 
Close on the Cycles Data dialog. 

 

Changes to other dialogs 

The improvements to hole canned cycles have resulted in a number 

of minor changes to other dialogs: 

In the Cycles Data and Edit Cycles dialogs: 

 the Canned Cycle column is renamed to Hole Canned Cycle. 

 

 beside each operation with a tool assigned, there is a new Edit 
Hole Operation button. 
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Thread Mill settings are now defined in the Edit Hole Operation dialog 

for a THREAD MILL hole canned cycle (see page 64). Previously, 
these settings were defined in the Hole Group Parameters dialog. 
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In the Process Parameters dialog: 

 The Output Hole Canned Cycle check box replaces the Canned 

Output check box. 

 

 The Hole Canned Cycle drop-down list replaces the Canned Cycle 

drop-down list. 
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 The Axial Step (Q) field is disabled.  

 

 There is a new Output Hole Canned Cycle check box.  
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In the Tool Data and Edit Tool dialogs, when a Tap tool is selected, 

an Axial Step field is added. This enables you to program an Axial 

Step for RIGID TAP cycles. 
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Improvements to canned cycles for 
Turning 

There are some improvements to canned cycles for Turning: 

In the Process Parameters dialog: 

 There is a new Output Profile option, where you can select 

whether to output the profile as programmed or compensated 

(see page 35). 

 The Output Canned Cycle for Turning check box replaces the 

Canned Output check box. 

 

In the Defaults for Turning dialog, the Output Canned Cycle for 

Turning check box replaces the Output Canned Cycles check box and 

is moved below the Apply Comp in PartMaker option in the Process 

Parameters area. 
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New Output Profile option 

In PartMaker/SwissCAM, PartMaker/Turn-Mill, and PartMaker/Turn, 
there is a new Output Profile option on the Process Parameters dialog 

that enables you to select how the Profile is output to the NC 

Program for a canned cycle for Turning. 

The Output Profile option is available for the following canned cycles 

for Turning: 

 Turning: Finishing operations 

 Turning: Roughing operations 

 Contouring: Finishing operations 

 Contouring: Roughing operations 

For Grooving, Threading, and Thread Whirling processes, and for 

processes using back turning tools, this option is not applicable. 

 

The following settings are available: 

Programmed — Select this option when you enter the tool nose 

radius in the Machine Tool's control. 

Compensated — Select this option when you do not enter the tool 

nose radius in the Machine Tool's control. 

 If Output Canned Cycle for Turning is deselected, Output Profile 

is unavailable. 
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Trimming turning toolpaths using 
stock profile boundaries 

Cutting limits define the area in which all cutting moves occur when 

machining a Turning toolpath. In previous versions of PartMaker, 

cutting limits defined only rectangular cutting areas. 

In PartMaker/SwissCAM, PartMaker/Turn-Mill, and PartMaker/Turn, 
you can now define non-rectangular cutting areas (for example, 

areas of unmachined stock) using stock profile boundaries. 

Trimming the toolpath to this cutting area reduces air-cutting, 

which, in turn, reduces machining time. 

To use a stock profile to define the cutting limits for a Turning 

profile group and trim the toolpath to this area: 

1 Click  in the Face window toolbar to display the Profile Group 

Parameters dialog. 

 

2 Specify settings for the toolpath. To use a stock profile to define 
cutting limits, you must: 
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a Select Turning from the Strategy drop-down list. Cutting limits 

are not available for other toolpath strategies. 

b Select the Roughing check box in the Operations area of the 

dialog. Stock profiles are applicable only to roughing 

operations. 

c Select Open from the Profile Shape drop-down list. Stock 

profiles must be open on one side. 

d Select To Stock Profile from the Toolpath Trimming drop-down 

list to specify that you want PartMaker to use the stock profile 
to set the cutting limits for the toolpath. PartMaker also 
updates the Cutting Limits Defined By drop-down list to select 

Stock Profile Boundaries to reflect your selection. 

3 Complete the remaining settings on the Profile Group Parameters 

dialog, then click Apply to create the profile group. 

4 Click Close to close the dialog. 

5 You can now create two profiles for the group: the part profile 

and the stock profile. By default, PartMaker uses the first profile 

you create as the part profile, and the second profile as the stock 

profile. For example: 

 Click  to create a profile for the part profile, then click  

and define the profile on a contiguous piece of geometry: 

 

 Click  to create a profile for the stock profile, then click  

and define the profile on a contiguous piece of geometry: 
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PartMaker displays both profiles in the profile group color and 

uses a: 

 thin line for the part profile (see )  

 thicker line for the stock profile (see ) 

 

 To change whether a profile represents a part profile or 
stock profile, double-click a profile line to display the Profile 

Properties dialog and change the profile type. 

6 To verify the toolpath for the profile group, select the profile 
group in the Job Explorer and select Part Features > Verify Work 

Group Tool Path. PartMaker verifies the toolpath. The following 

example compares the toolpaths created when a stock profile 
defines the cutting limits and when a part profile defines the 

cutting limits: 

Cutting limits defined by the part 
profile 

Cutting limits defined by the 
stock profile 
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Vertical Rotary table support in 
PartMaker/Mill 

A Vertical Rotary table is used on a 5 axis head-table Vertical Milling 

Center with a rotary table and a tilting head. These tables are 

usually used for milling large, heavy, parts since the table does not 

tilt, and tilt is instead achieved by the tool head. 

PartMaker/Mill 2015 includes support for head-table Vertical Milling 

Centers, and you can select a Vertical Rotary table when defining 

your table settings. 

 For the Vertical Rotary table option to be available, you must 
have PMM (Product Milling Module) licensed. 

To select a Vertical Rotary Table: 

1 In the Setup dialog, click Settings. A Table Settings dialog for the 

currently selected table is displayed. 

2 In the Table Type drop-down list, select Vertical Rotary. The 

Vertical Rotary Table settings are displayed on the dialog.  

 

3 The Table Settings dialog controls how the table appears in basic 

simulation. Enter the settings for your table in the available 

fields. 
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4 If you have Vertical Mill-Turn(VMT) licensed, and have selected a 
Cylinder stock, select Use Turning in Job to enable you to use 

Turning in PartMaker/Mill (see page 42). 

5 Click OK. Several dialogs are updated (see page 40). 
 

Changes to other dialogs when a Vertical Rotary table is 
selected 

When you have a Vertical Rotary table selected on the Table Settings 

dialog, there are changes to several other dialogs: 

 In the Setup dialog: 

With a Box stock selected, the following options are available 

from the Machining Function drop-down list: 

 

 Mill XY Plane 

 Mill 5 Axis Plane. 

With a Cylinder stock selected, the following options are available 

from the Machining Function drop-down list: 

 

 Mill XY Plane 

 Mill 5 Axis Plane 

 Mill End, Index 

 Mill End, Polar 

 Mill Diam, Index 

 Mill Cylinder 
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 Turn (This is available only if Use Turning in Job is selected on 

the Table Settings dialog). 

 In the Post Options dialog, the Output Coordinate System area 

displays options for Vertical Rotary tables. 

 

 There are some changes to the Machine Data dialog. These are 

described in Updates to the Machine Data dialog (see page 48). 
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Using Turning in PartMaker/Mill 
PartMaker/Mill 2015 includes programming, simulation and 

postprocessing capabilities for Vertical Mill-Turn (VMT) machines.  

A VMT machine is a Vertical Milling machine that has the ability to 

perform a range of turning functions by enabling the machine's 
vertical rotary table to rotate at the speed of a lathe spindle. VMTs 

combine the turning capabilities of a Vertical Turret Lathe (VTL) and 

the machining capabilities of a 5-axis Vertical Machining Center 

(VMC). 

 For Vertical Mill-Turn support, you must have the Vertical 

Mill-Turn(VMT) module licensed. 

To use turning in PartMaker/Mill: 

1 In the Setup dialog, select Cylinder from the Stock drop-down 

list. 

2 Click Settings to display the Table Settings dialog. 

3 From the Table Type drop-down list, select either a Rotary 5 Axis 

or Vertical Rotary table. The Use Turning in Job option is 

displayed below the drop-down list. 

 

4 Select Use Turning in Job and click OK. Several dialogs are 

updated (see page 43). 
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Changes to other dialogs when Turning is enabled in 
PartMaker/Mill 

When you select Use Turning in Job to enable Turning in 

PartMaker/MILL, the following changes are made to the user 

interface: 

 In the Setup dialog: 

 Turn is added to the Machining Functions drop-down list. 

 

 If you are using a Rotary 5 Axis table and have selected Turn 
from the Machining Function drop-down list, the Turning 

Machine Position  button is displayed in the Table area. 
Click this button to display the Turning Machine Position dialog 

and select the orientation of the stock (see page 47). 
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 In the Tool Data and Edit Tool dialogs, Turning tools are available 

from the Type drop-down list. 

 

When you select a Turning tool, the settings available on the Tool 

Data and Edit Tool dialog are the same as when you select a 

Turning tool in PartMaker/SwissCAM and PartMaker/Turn-Mill, 
except there is no Tool Post field.  

 In the Tool Properties dialog, when you have a Vertical Rotary 
Table selected in the Table Settings dialog: 

 The Inclined Tool Properties area is available. 

 

Use B-Angle for Toolpath Calculations and Simulation is 

unavailable if Z-Axis is selected in the Shank Axis list on the 
Tool Data or Edit Tool dialogs. 

There are different Head-Table machine architectures that use 

inclined tools. PartMaker 2015 only supports inclined turning 

tools for machines where the tool head remains in the ZX 

plane while rotating about the Y-axis.  



 

 PartMaker 2015 What's New in PartMaker 2015 • 45  

 The Output Coordinates Shift and Negative Diameter options are 

available. 

 

 In the Solids Window toolbar, the Extract Turn Geometry 
button is available if you select Turn from the Machining Function 

drop-down list in the Setup dialog.  

 

 In the Holder Data dialog, new options enable you to choose 

between a Milling holder and a Turning Holder. 

 

 In the Simulation Options dialog, the Cosmetic Thread, Turning 

Insert Thickness, and Max ID Tool Holder Thickness settings are 

available. These settings were previously available only in 

PartMaker/SwissCAM, PartMaker/Turn-Mill, and PartMaker/Turn.  

 

 For more information on these options, see the Reference 

Help. 
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 In the Cycles Data dialog, the Cycle For area is added, which 

enables you to select whether the cycle is for Turning or Milling. 

 

 When you select Job Optimizer > Defaults, the Define Defaults For 

dialog is displayed where you can choose to display the Defaults 

dialog for Milling or Turning. 

 

 In the Process Parameters dialog for Turning processes, the Tool 

Change Point Y parameter is available. The values for Tool 

Change Point X, Y, and Z are taken from the Defaults for Milling 

dialog.  

 

In PartMaker/SwissCAM, PartMaker/Turn-Mill, and 

PartMaker/Turn, the Y value is set to 0 and the field is 

unavailable. 

 There are some changes to the Machine Data dialog. These are 

described in Updates to the Machine Data dialog (see page 48). 
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Changing the orientation of the stock 

In PartMaker/Mill, you can use the Turning Machining Position dialog 

to change the orientation of the stock for turning operations when 

you are using a Rotary 5 Axis table.  

 

To display this dialog, click the  button in the Table area of the 
Setup dialog. This button is only available when you have the 

following:  

 Rotary 5 Axis selected from the Table drop-down list in the 

Table Settings dialog. 

 Use Turning in Job selected in the Table Settings dialog. 

 Turn selected in the Machining Functions drop-down list in the 

Setup dialog. 

If you change the orientation from vertical to horizontal, the graphic 
in the Orientation area of the Setup dialog is updated, and the 

button changes from  to . 

Vertical stock orientation Horizontal stock orientation 

  

If you select a Horizontal stock rotation, the New Hole Group button 

on the CAM window toolbar is unavailable.  
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Updates to the Machine Data dialog in 
PartMaker/Mill 

The Machine Data dialog enables you to specify information about 

how your machine is represented during Full Machine Simulation.  

  

In PartMaker/Mill 2015, there are several changes to the Machine 

Data dialog as result of PartMaker/Mill now supporting Vertical 

Rotary tables and Vertical Mill-Turn machines, and to bring 
terminology in line with industry standards. 

 The Milling Machine Configuration area is renamed to Machine 

Configuration. 

 In the Machine Configuration area: 

The Type drop-down list is renamed to Machine Type, and the 

available options are updated: 

 

 Vertical Machine is renamed to Vertical Milling Center. 

 Horizontal Machine is renamed to Horizontal Milling Center. 
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 Vertical Mill-Turn is added. This option is available only if you 
are licensed for the Vertical Mill-Turn (VMT) module (see page 

42). 

When you select Vertical Milling Center, the options available in 
the Axis Configuration drop-down list are updated: 

 

 3-Axis Machine is renamed to 3-Axis. 

 4-Axis Machine is renamed to 4-Axis. 

 5-Axis Machine is replaced by 5 Axis Head-Table and 5 Axis 
Table-Table.  

When you select Vertical Mill-Turn, only 5 Axis Table-Table and 5 
Axis Head-Table are available from the Axis Configuration 

drop-down list. 

 

The Table Configuration drop-down list is renamed to Table Type.  

 In the Table area, there are two additional motion axes 

displayed. When you have a Vertical Rotary table selected in the 
Table Type drop-down list, click Properties to display the new 
Vertical Rotary Table Properties dialog (see page 51). 
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 The Tool Head area replaces the Tool Spindle area, and there are 

two additional motion axes displayed. There are also updates to 
the Tool Head Properties dialog (see page 50). 

 
 

Tool Head Properties dialog 

In the Tool Head Properties dialog:  

 There is a new Swivel Axis area. This is the 4th rotational axis in 

a 5-axis Head-Table machine, and is the axis about which the 

tool head rotates. 

 

 Y Axis — Select this option to indicate that the rotary axis of 

the tool head is along the Y-axis of the machine. When 

selected, PartMaker displays horizontal tools along the X-axis 

during Basic and Full Machine Simulation.  

 45 Degree Line — Select this option to indicate that the rotary 

axis of the tool head is along a 45 degree line to the machine 

Y-axis lying in a ZY plane. When selected, PartMaker displays 

horizontal tools along the Y-axis during Full Simulation. 

 PartMaker programs all horizontal tools on a Vertical 
Rotary table as X tools. Although, PartMaker displays 

the horizontal tool along the Y-axis when 45 Degree 

Line is selected, it is still programmed as an X tool. 
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 There is a new Pivot Point (P) area. The Pivot Point is a point on 

the tool head through which the tool head rotary axis passes. 
Specify the X, Y, and Z distance from the tool head edge to the 

center of rotation. 

 
 

Vertical Rotary Table Properties dialog 

Use the Vertical Rotary Table Properties dialog to specify details 

about the table and how it is displayed in Full Machine Simulation. 

To specify how the Vertical Rotary Table is displayed in Full Machine 

Simulation: 

1 Select ToolMinder > Machine to display the Machine Data dialog. 

2 In the Machine Configuration area, select either Vertical Milling 

Center or Vertical Mill-Turn from the Machine Type drop-down 

list. 

 The Vertical Mill-Turn option is available only if you have 

Vertical Mill-Turn(VMT) licensed.  

3 Select 5 Axis Head-Table from the Axis Configuration drop-down 

list. Vertical Rotary is selected automatically in the Table Type 

drop-down list. 
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4 In the Table area, click Properties to display the Vertical Rotary 

Table Properties dialog.  
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Support for compound rotary holders 
Compound rotary holders are holders that have a fixed part (base 

model) mounted to the tool post, and a rotating part (rotary 

model). 

In PartMaker/SwissCAM and PartMaker/Turn-Mill you can now define 
the base model and rotary model of a compound rotary holder 

separately. Previously compound rotary holder models were created 

as one piece. They were created at common angles so you would 

have to choose a holder with an angle that was closest to your tool 
angle for a given process. 

As a result of this improvement, there are changes to the Holder 

Data dialog, and there is a new Set Holder Models dialog. 

Holder Data dialog 

In the Holder Data dialog: 

 There are two new radio buttons so you can select whether you 
have a Milling Holder or a Turning Holder. Only Milling holders can 

be compound rotary holders. 

 

 The Model Data button is removed and replaced with the Holder 

Models button. Click this button to display the Set Holder Models 

dialog. 

 



 

54 • What's New in PartMaker 2015  PartMaker 2015  

 If you select Parametric, the Holder Models button is 

unavailable because the dimensions of the holder are 
defined in the Parametric Dimensions area. 

Set Holder Models dialog 

Use the Set Holder Models dialog to control how the holder is 

displayed during Full Machine Simulation. 

 

To display this dialog, click the Holder Models button on the Holder 

Data dialog. 

The following settings are available: 

Model Configuration — Select what type of holder you have. If you 

selected Turning Holder on the Holder Data dialog, this drop-down 

list is unavailable. 

Standard Fixed — Select this option if you have a standard fixed 

holder. Only the Model Data button is available. 

Compound Rotary — Select this option if you have a compound 

holder. This option is not available for Turning holders. 

Model Data — Click to display the Model Data dialog.  

Base Model Data (1) — Click to display the Model Data dialog and 

define the properties of the compound holder's base model. 

Rotary Model Data (2) — Click to display the Model Data dialog and 

define the properties of the compound holder's rotary model.  

Angular Position 
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Set Manually — Select this option if your compound holder is 

rotated manually by the machine operator prior to running the 

NC program. 

Programmable — Select this option if the angle of your holder is 

programmed in the NC code. 

Rotation Center (C) — Enter the position of the Rotation Center. The 

rotation center is measured from the model origin of the Base Model 

to the model origin of the Rotary Model. 

Rotary Axis — Select the axis in which the Rotary Model rotates 

about to get to a specific angular position. 
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Applying nose radius compensation to 
each process 

 

The Apply Comp in PartMaker option controls whether PartMaker 

compensates the toolpath output to the NC Program based on the 

tool nose radius, so that you do not need to enter the tool nose 
radius in the control. In PartMaker 2015, you can choose to apply 

cutter compensation per process for turning, rather than using the 
Defaults for Turning dialog as a global setting for every turning 

process on the Process Table.  

 

Apply Comp in PartMaker can be programmed for the following 

operations: 

 Turning: Finishing operations 

 Contouring: Roughing operations 

 Contouring: Finishing operations 

 Grooving: Finishing operations 
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Axial step control 
In PartMaker/SwissCAM, PartMaker/Turn-Mill, and PartMaker/Mill, 
there is a new Axial Step Control drop-down list that enables you to 

control whether or not the tool retracts back to the start position 
between Z moves in a Contour Mill strategy with a Tool Position of 

On. This means you can avoid unnecessary rapid moves back to the 
start of the profile between passes.  

 

The Axial Step Control option is available only when you have a Mill 

XY Plane, Mill ZY Plane, Mill 5 Axis Plane, Mill End Polar, or Mill 4 Axis 

Plane machining function selected. 

The Axial Step Control drop-down list contains the following options: 

Return to Start Point — If selected, the tool retracts to the start 

position (see ) before the next Z step down.  

 

  Plunge moves (purple). 

  Cutting moves (red). 

  Retract moves (yellow). 
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Stay at Depth — If selected, the tool stays at depth without 

retracting until the final depth is reached. 

 

  Plunge moves (purple). 

  Cutting moves (red). 

  Retract moves (yellow). 
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Simulation Options dialog 
There are some changes to the Simulation Options dialog.  

 

There are two new options in the Settings area of the dialog: 

Enable Multithreading for Calculations — Select this option to 

increase simulation speed (see page 60). 

Automatically Close Custom Shape Models — Select this option to 

fix invalid custom solid models (see page 59). 

The Colors and Textures area is renamed to Colors. 
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Fixing invalid solid models 

In PartMaker 2015, you can fix custom shape solid models that 

have missing or self intersecting faces so that these solid models 

can be used in simulations. 

To fix invalid custom shapes: 

1 Select Simulation > Simulation Options from the menu bar. 

2 In the Settings area, select Automatically close Custom Shape 

Models. 

 

3 Click OK to close the dialog. 
 

Increasing simulation speed 

In PartMaker 2015, you can take advantage of your computer's 

multithreading capabilities to increase the speed of your simulation.  

To use multithreading when running a simulation, select Enable 

Multithreading for Calculations in the Settings area of the Simulation 

Options dialog. This option is deselected by default. 
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User interface changes 
PartMaker 2015 includes the following improvements to the 

PartMaker user interface: 

 Profile Group Parameters, Turn dialog (see page 62) — There are 

several changes to this dialog when you have a Turning strategy 
selected. 

 Define Custom Shape dialog (see page 63) — There are changes 

to the terminology and layout of the Define Custom Shape dialog. 

 Thread mill settings (see page 64) — The thread mill settings are 

now located on the Edit Hole Operation dialog. 

 5-Axis Rotary Table Properties (see page 65) — The Primary and 

Secondary Rotary axes are renamed. 

 Viewing tool parameters (see page 66) — Tool parameters of 

unlicensed tools can be viewed but not edited in the Tool Data 

and Edit Tool dialogs. 

 Using the Manage Tools Files dialog (see page 69) — There are 

several changes to the Manage Tools Files dialog. 

 In PartMaker/Mill, the following dialogs are updated: 

 Machine Data dialog (see page 48). 

 Setup dialog (see page 67).  

 Table Settings dialog (see page 65). 

 The following options retain the same function, but are renamed: 

 In the Tool Data and Edit Tool dialogs, the User Defined Shape 

option replaces the User Defined option. 

 The Tool Head Properties dialog replaces the Tool Spindle 

Properties dialog. 

 In the Holder Data dialog, Tool Head replaces Tool Spindle. 
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Profile Group Parameters, Turn dialog 

When you have a Turning strategy selected in the Profile Group 

Parameters, Turn dialog, there are the following changes to the 

dialog in PartMaker 2015:  

 The Profile Shape option is renamed to Part Profile. 

 

 A new Toolpath Trimming drop-down list is available, which 

enables you to trim the toolpath to a cutting area defined by a 

stock profile (see page 36). 

 

 The Cutting Limits Defined By area of the dialog has been 

removed and replaced by a drop-down list: 

 

 The options available for defining cutting limits are now: 

 Cutting Point (same as PartMaker 2014). 

 Part Profile Boundaries (known as Profile Boundaries in 
PartMaker 2014). 

 Stock Profile Boundaries (new in PartMaker 2015). 

If you select None from the Toolpath Trimming drop-down list, 

the Stock Profile Boundaries option is unavailable. If you 
select To Stock Profile from the Toolpath Trimming drop-down 

list, Stock Profile Boundaries is selected automatically and the 

other options are unavailable. 
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Define Custom Shape dialog 

The Define Custom Shape dialog includes the following changes: 

 The Use as Stock Shape option is now called Use as Initial Stock 

Shape. This change emphasizes that PartMaker uses the custom 

shape as the initial stock shape only during simulation. 

 

 The Define Custom Shape dialog now groups the settings for 
defining a custom shape together in a Shape Definition area: 
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Thread Mill settings 

In PartMaker 2015, the thread mill settings for holes are located on 
the Edit Hole Operation dialog  when you have a THREAD MILL hole 

canned cycle selected (see page 19). Previously these settings were 
located on the Profile Group Parameters dialog when you selected a 

Thread Mill strategy. 
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Table Settings dialog 

In PartMaker/Mill, you can now select your Table type from the 
Table Settings dialog, rather than on the Setup dialog. Each Table 

Settings dialog now has a Table area that includes a drop-down list 

of Table types and a picture illustrating the selected table. When 

you select a table from the drop-down list, the properties on the 
dialog are updated to reflect the selected table. 

 

When you have a Rotary 5 Axis table or Vertical Rotary table 
selected, there is a new Use Turning in Job option. Select this option 

to enable turning in PartMaker/Mill. Use Turning in Job is available 

only if you have the Vertical Mill-Turn (VMT) module licensed (see 

page 42). 
 

5-Axis Rotary Table Properties dialog 

In the 5 Axis Rotary Table Properties dialog, the Primary Rotary Axis 

and Secondary Rotary Axis are renamed to bring PartMaker in line 

with standard naming conventions. The position of these settings in 

the dialog is also reversed so that the Primary Rotary Axis is 

positioned before the Secondary Rotary Axis. 

Secondary Rotary Axis for Top Table replaces Primary Rotary Axis for 

Top Table. 



 

66 • What's New in PartMaker 2015  PartMaker 2015  

Primary Rotary Axis for Bottom Table replaces Secondary Rotary Axis 

for Bottom Table. 

 
 

Viewing tool parameters 

When you load a Tool Database (.tdb) file that contains tools which 

are not licensed by your version of PartMaker or are not applicable 

to your module, the parameters of a tool are displayed when you 
select it from the drop-down list, but the fields are disabled so they 

cannot be edited or selected. 
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For example, if you select a milling tool when using PartMaker/Turn, 
the Tool Data dialog looks as follows: 

 
 

Updated Setup dialog in PartMaker/Mill 

There are the following changes to the Setup dialog in 

PartMaker/Mill: 

 Mill End, Index and Mill End, Polar are added to the Machining 

Function drop-down list when either a Rotary 5 Axis table or 

Vertical Rotary table with Cylinder stock is selected. These 
options were previously available only in PartMaker/SwissCAM 

and PartMaker/Turn-Mill. 
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 When you have a Rotary 5 Axis table selected with a Mill Cylinder 
or Mill Diam, Index Machining Function, 2D coordinates in the 

Boundaries window are now displayed as Z, C to ensure a 

uniform method of programming that is also consistent with 

machine programming conventions. 

 Turn is added to the Machining Function drop-down list when Use 

Turning in Job is selected on the Table Settings dialog (see page 

42). 

 In the Table area, the Settings button and table drop-down list 
have swapped positions. You now select your table in the Table 

Settings dialog (see page 65).  

 There is a new Turning Machine Position button in the Table area 

when a Rotary 5 Axis table is selected on the Table Settings 

dialog (see page 47). 

 The Z Face (F) field is removed if you select a Mill XY Plane, Mill 
End, Index, or Mill End, Polar face from the Machining Function 

drop-down list (see page 68). 
 

Z Face field in PartMaker/Mill 

In PartMaker/Mill, when you have a Rotary 5 Axis table selected 
with a cylindrical stock, the Z Face (F) field is removed from the 

Setup dialog if you select a Mill XY Plane face from the Machining 

Function drop-down list.  

The Z Face field is also removed from the Define Face Plane dialog if 

you have a Rotary 5 Axis table selected with cylindrical stock. 

In PartMaker 2015, if you open an old job with a non-zero Z Face (F) 

value for a Mill XY Plane face, a message is displayed asking you to 

adjust the Z_Surf value for all groups. 
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Using the Manage Tools Files dialog 

There are several changes to the Manage Tools Files dialog. 

Availability of tools in the Type drop-down list 

In PartMaker 2015, all tool types are included in the Type 

drop-down list, no matter which version of PartMaker you are 
running. Previously, the Type drop-down list only included tools that 

were applicable to the version of PartMaker you were running.  

 

Editing tools 

If you select a tool from either the Tool Database or Master Tools 

Database, which you are not licensed to use in your version of 
PartMaker, the Edit button is unavailable.  

 In PartMaker/Mill, you can edit turning tools if you have 

Turning enabled (see page 42).  
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Saving the Master Tools Database 

You can now choose to save the Master Tools Database file to 
PartMaker .TDB or Excel .CSV format. If you save to .tdb, any 

cutting data associated with individual tools in the database is 
preserved (see page 11). If you save to .csv, a message is displayed 

warning you that cutting data will not be saved. 
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ConfigPost enhancements 
ConfigPost 2015 includes the following enhancements: 

 New and updated reserved words (see page 71) — There are 

several new and updated Reserved words. 

 Postprocessing canned cycles for holes (see page 73) — There are 

enhancements to support the new hole canned cycles in 
PartMaker. 

 User Data Names dialog (see page 77) — More user conditions 

and user parameters fields are added to the User Data Names 

dialog. 

 Variables Names dialog (see page 78) — A third tab of variables is 
added to the Variable Names dialog.  

 File compatibility (see page 78) — There are changes to the 

compatibility of .pst/.sub/.wri files created in previous versions of 

ConfigPost. 

 Machine Settings in ConfigPost (see page 79) — There is a new 

Machine Settings option in the Settings menu to enable you to 

indicate the type of Post File used 

 Naming Convention for Post Files (see page 80) — The naming 

convention for Post Files in ConfigPost is changed. 
 

New and updated reserved words 

ConfigPost 2015 includes new several new and updated reserved 

words: 

New reserved words 

The following reserved words have been added:  

 <face-tool> — Used to specify whether a Face turning tool is 

being used.  

 <is-final-thread-pass> — This word is TRUE during the final 

entire pass when a Threading Strategy is selected in the Profile 
Group Parameters, Turn dialog. If spring passes are used, this 

word will be true on the final spring pass. This word should not 

be referenced when a THREAD canned cycle is used.  

 <is-z-shank-axis> — Used to specify the orientation of the OD 

tool. This word is set to true when the Shank Axis is set to Z Axis 

for turning tools in the Tool Data dialog. 
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 <local-origin-nrt-x> — Used primarily for PartMaker/Mill to 

specify non-rotated local origin coordinates. 

 <local-origin-nrt-y> — Used primarily for PartMaker/Mill to 

specify non-rotated local origin coordinates. 

 <local-origin-nrt-z> — Used primarily for PartMaker/Mill to 

specify non-rotated local origin coordinates. 

 <num-thread-passes> — Used to specify the number of 

threading passes in a Threading group.  

 <right-orient-in-group> — Used to specify the tool 

orientation from the profile group parameters. This word is set to 
true if Tool Orientation is set to Right in the Profile Parameters, 

Turn dialog. 

 <thread-mill-internal> — This word is set to true when 

thread milling an ID thread. 

 <time> — Used to reproduce the time when the part program 

was post processed. The time format matches the computer's 

regional settings. 

 <tool-next-on-toolpost> — Used to specify the next tool 

number on the same tool post. This word will return the next tool 

on the tool post if it is different from the current tool. 

 <toolpost-next-on-spdl> — Used to specify the next tool post 

to be used on the current spindle. PartMaker/SwissCAM and 

PartMaker/Turn-Mill only.  

Updated reserved words 

The following reserved words have been updated: 

 <cw-spindle> — The description is updated because the spindle 

direction is now set using the Spindle Direction field. 

 <diam-sign> — You can now use this word in ConfigPost when 

the Target Application is PartMaker/Turn. 

 <local-origin-x> — This word is renamed to 

<local-origin-rot-x>. It is used primarily for 

PartMaker/SwissCAM and PartMaker/Turn-Mill to specify rotated 
local coordinates. 

 <local-origin-y> — This word is renamed to 

<local-origin-rot-y>. It is used primarily for 

PartMaker/SwissCAM and PartMaker/Turn-Mill to specify rotated 
local coordinates. 
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 <local-origin-z> — This word is renamed to 

<local-origin-rot-z>. It is used primarily for 

PartMaker/SwissCAM and PartMaker/Turn-Mill to specify rotated 
local coordinates. 

 <next-tl-num-on-chnl> — This word is renamed to 

<tool-num-next-on-chnl>. 

 <num-passes> — This word is renamed to 

<num-spring-passes>. 

 <rapid-abs> — This word is replaced with <rapid-abs-x> (X 

coordinate for X-oriented tools) and <rapid-abs-z> (Z 

coordinate for Z-oriented tools). 

 <tool-nose-com> — The description is changed to explain that 

you can use this word to specify the nose compensation value for 

a mill as well as a lathe. 

 <tool-nose-rad> — The description is updated because this 

word works in Milling as well as Turning. 

 <tool-post> — This word is renamed to <toolpost>. 

 <tool-post-next> — This word is renamed to 

<toolpost-next>.  

Canned cycles for holes 

There are several new reserved words, and some changes to 

existing reserved words, to support the new canned cycles for 
holes. See New and changed reserved words for canned cycles for 

more details (see page 75). 
 

Postprocessing canned cycles for holes 

ConfigPost includes the following changes to support the 

enhancements to canned cycles for holes in PartMaker/SwissCAM, 
PartMaker/Turn-Mill, PartMaker/Turn, and PartMaker/Mill: 

 The ability to configure how a Post file uses the new canned 

cycles for holes (see page 73). 

 New and changed reserved words (see page 75). 
 

Configuring canned cycles for holes 

PartMaker 2015 includes the following new canned cycles for holes: 

 CHIP BREAK (turning and milling) (see page 23) 

 VARIABLE STEP (turning and milling) (see page 25) 

 HELICAL MILL (milling only) (see page 27) 
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To specify how a Post Configuration file processes these canned 

cycles you can: 

 Specify the machining codes for cycles on the Preparatory 

Functions dialogs. For example, on the Preparatory Functions, Mill 

dialog: 

 

 Use the new options that are available in the Configure Mill > 

Canned Cycle Formats and Configure Turn > Canned Cycle Formats 

menus to configure the new CHIP BREAK, VARIABLE STEP, and 

HELICAL MILL canned cycles.  
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For example, select Configure Turn > Canned Cycle Formats > 

VARIABLE STEP cycle to display the VARIABLE STEP Cycle, Turn 

dialog: 

 
 

New and changed reserved words for canned cycles 

ConfigPost 2015 includes new reserved words, and changes to 

existing reserved words, to support the changes to canned cycles 
for holes in PartMaker (see page 18). 

New reserved words 

<hole-diameter> — Used to specify the Hole Diameter of the hole 

canned cycle. 

<is-full-retract> — This word is set to TRUE if the Retract Type 

for a hole canned cycle is Full Retract. Not all machines support this 

in a canned cycle. 

<init-step-feed-fact> — Used to specify the feed rate factor for 

the initial step in a VARIABLE STEP hole canned cycle. 

<radial-step> — Used to specify the Radial Step of a CIRCLE MILL 

hole canned cycle. 

<retract-dist> — Used to specify the retract distance for CHIP 

BREAK and VARIABLE STEP hole canned cycles. Not all machines 

support this in a canned cycle. 

<step-decrease> — Used to specify the decrease in speed after the 

initial step for a VARIABLE STEP hole canned cycle. Not all machines 

support this in a canned cycle. 
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<step-min> — Used to specify the minimum step performed in a 

VARIABLE STEP hole canned cycle.  

<thread-mill-left-hand> — Used to specify the direction of the 

thread when thread milling. This word is set to true when the 
Thread Direction is set to Left Hand in the Profile Group Parameters or 

Edit Hole Operation dialogs. 

<thread-mill-top-down> — Used to specify the style of the thread 

when thread milling. This word is set to true when the Style is set to 

Top Down in the Profile Group Parameters and Edit Hole Operation 

dialogs.  

Changes to existing reserved words 

<can-cyc> — The description is updated because the Canned Output 

check box is renamed to Output Hole Canned Cycle for drilling 

processes, and Output Canned Cycle for Turning for turning 

processes. 

<num-spring-passes> — Replaces <num-passes>. Previously this 

was used only for threading to specify the number of spring passes 
for finishing a thread (as specified on the Thread Options dialog). 

Now, it is also used for the HELICAL MILL canned cycles to specify 

the number of spring passes at the bottom of a hole (as specified on 
the Edit Hole Operation dialog). 

<step> — The description is updated because the Axial Step (Q) field 

is added to the Edit Hole Operation dialog. 

<step1> — The description is updated because the Axial Step (Q) 

field is located on the Edit Hole Operation dialog in addition to the 
Profile Group Parameters - Grooving dialog. 
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User Data Names dialog 

The User Data Names dialog enables you to add your own logical 

reserved words (User Conditions) and string reserved words (User 

Parameters) to a Post file. In PartMaker 2015, the number of User 

Conditions you can add is increased from 15 to 31, and the number 
of User Parameters you can add is increased from 7 to 15.  
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Variables Names dialog 

The Variables Names dialog enables you to enter your own variables 

to a Post file. In PartMaker 2015, another tab has been added to the 

dialog, which means that the number of variables you can add is 

increased from 83 to 125. 

 
 

File compatibility in ConfigPost 

In ConfigPost 2015, there are changes to the compatibility of .pst, 

.sub, and .wri files that were created in previous versions of the 

software: 

 .pst and .sub files produced in ConfigPost 2014 are compatible 

with ConfigPost 2015.  

 .wri files produced in ConfigPost 2014 are not compatible with 

ConfigPost 2015. 
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New Machine Settings option in ConfigPost 

In ConfigPost 2015, there is a new Machine Settings option in the 

Settings menu to enable you to indicate the type of Post file used. 

This option is available only when PartMaker/Mill is selected as the 

Target Application. 

 

Select this option to display the Machine Settings dialog, where you 

can select your machine type, axis configuration, and table type. 

The options on this dialog are the same as those found in the 
Machine Configuration area of the Machine Data dialog in 

PartMaker/Mill (see page 48). For new and existing Post files, all the 
fields are set to Not Specified until you select options from the 

drop-down lists. 

 

Select Vertical Mill-Turn from the Machine Type drop-down list to 

make the Configure Turn menu available on the Main menu bar. 
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Naming convention for Post Files 

There are changes to the naming convention used when you create, 

modify, or save a distribution Post File in ConfigPost. 

When you create, modify, or save distribution Post File in ConfigPost 

2015 the character 'e' is appended after 'v' in the distribution Post 
File name. For example, Citizen_M3_32-ve122.pst. 
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If you are a new PartMaker user, you may want to use the following 
resources to help you get started: 

 Help and documentation (see page 81). 

 Training (see page 81). 

If you experience any problems when installing or using PartMaker, 
contact technical support (see page 82). 

If you require any modifications to the Distribution Post files you 

have licensed, refer to the Post Processor modification policy. 
 

Help and documentation 
To help you get started, PartMaker is supplied with a comprehensive 
online Reference Help, which you can access from the Help menu. 

Further documentation is also provided on the PartMaker 

Documentation CD.  

You can also download documentation from the Delcam Customer 

Downloads Center (http://updates.delcam.com/login.php), as 
described in Technical support for PartMaker (see page 82). 

 

Training for PartMaker and ConfigPost 
A wide variety of PartMaker and ConfigPost training programs are 

available from PartMaker, Inc., Delcam Ltd and their sales agents as 

follows: 

In North America 

 PartMaker, Inc, see the Training section of the PartMaker website 

(www.partmaker.com). 

Outside of North America 

Help and support 

http://updates.delcam.com/login.php
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 Delcam Ltd, see the Training section of the Delcam website 

(www.delcam.com). 

 Delcam Ltd sales agents, contact your sales agent directly. The 
Delcam website (www.delcam.com) contains a list of sales 

agents and their contact details. 
 

Technical support for PartMaker 
Customers with an annual maintenance agreement can obtain 

technical support for PartMaker. This support may be provided by 
phone, email or by accessing technical support information available 

on the Internet. 

Before contacting technical support, please refer to the 

documentation and help supplied with PartMaker to see if you can 

find information to solve your query.  

Internet support 

You can also access software releases, documentation, technical 

notes and videos from the Delcam Customer Downloads Center 
(http://updates.delcam.com/login.php). 

Phone and email support 

If you are unable to resolve your query, make sure you do the 
following before contacting technical support: 

 You know the name and version of the PartMaker product you 

are using. 

 You are able to describe the problem in detail. You may find it 
useful to document exactly what happened. 

 If possible, be sure you can reproduce the problem. A support 

technician may ask you do this while you are on the phone. 

 Be prepared to submit job (.job), tools (.tdb), cycles (.cdb) and 

Post Configuration files (.pst and .sub), as well as sample NC 

programs as attachments to an email message. Always try to zip 

your files using the WinZip program to make it easier and 

quicker to send the files by email. 

 PartMaker will automatically zip the files if you use the Help 

> Technical Support option within PartMaker and select the 

Send Files button.  

To contact your local provider of technical support: 

 For PartMaker, Inc in the United States, email 

support@partmaker.com or phone 215-643-5077. 

http://updates.delcam.com/login.php
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 For Delcam Ltd in the United Kingdom, email 

support@delcam.com or call 0121 683 1010. 

 For other countries, contact your local sales agent. Contact 
details for Delcam sales agents are available on the Delcam 

website. 

 


